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Sažetak

Tema ovog rada je alat Paint Effects unutar 
Autodesk Maya softvera, a u radu ćete diskutirati 
o korištenju predefiniranih, gotovih 2D i 3D
efekata u Mayi, koje, ako dobro znate koristiti 
te uz sve tegućnosti manipuliranja i stvaranje 
vlastitih brusheva tegu izgledati točno onako 
kako ste to zamislil. Spomenuti ćete osnovne 
tegućnosti, pojteve, procese i definicije potrebne 
za razumijevanje Maya Paint Effects programa, 
ključne izbornike i alate, načine njihova korištenja 
i objasniti kako se snaći u sučelju.

Ključne riječi: 3D tedeliranje, Pain efekti, 
Autodesk Maya, 2D Slikanje, 3D Slikanje, 
Teksturiranje, Kistovi, Animacija

Abstract

The topic of this article is a tool within Autdesk 
Maya Software called Paint Effects. In this paper 
we will discuss usage of predefined, ready-made 
2D and 3D effects in Maya, which, if well used 
and with all the possibilities of manipulation 
and free creation may look exactly the way we 
imagined. We will mention the basic features, 
concepts, processes and definitions required 
for understanding Maya Paint Effects program, 
crucial menus and tool, methods of their use and 
also explain how to manage the user interface of 
Paint Effects.

Keywords: 3D tedeling, Paint Effects, Autodesk 
Maya, 2D Painting, 3D Painting, Texturing, 
Brushes, Animation

1. Uvod

1. Introduction

Specijalni efekti u Mayi ne simuliraju sate fizičke 
fenomene kao što su vatra i dim, već i prirodne 

pokrete sudaranja fizičkih tijela. Dinamički 
sustav u Mayi uključuje dinamička tijela 
(Dynamics) u koja spadaju tijela (Rigid bodies), 
čestice (Particles), kosu (Hair), fluide (nFluid) i 
simulaciju tkanine (nCloth). [5]
Drugi Mayin dinamički baziran alat za animaciju, 
Paint Effects, teže stvarati dinamička polja trave, 
glavu punu kose, čak i šarene aurore na nebu i 
ostale slične sustave u sate nekoliko minuta. 
Paint Effects je komponenta u Mayi koja je 
dizajnirana kako bi se na brz i jednostavan način 
stvorili potezi kista ili efekti čestica na 2D platnu 
ili na/između 3D geometrije. Dakle, Paint Effects 
se teže koristiti kao u tradicionalnom programu 
za slikanje slika na platnu, ili za stvaranje 
ponavljajućih tekstura koje se tegu primjeniti 
na geometriju u sceni. No, Paint efekti u Mayi 
idu mnogo dalje od tradicionalnog/digitalnog 
slikanja. Na 2D platnu, jedna vrsta kista teže 
proizvesti kompleksnu sliku, na primjer drveće ili 
cvijeće. Primjenjen u 3D prostoru, isti taj kist teže 
proizvesti cijelo drvo - dimenzionalno. Također, 
na Paint efekte tegu se primjeniti sile, kao što 
su turbulencija ili gravitacija, i tako stvoriti 
animaciju ili kretnja, kao što je vijorenje trave, 
rast biljaka, efekt vjetra u kosi ili strujanje rijeke. 
Osim gotovih kistova kao što su biljke, kosa, 
vatra, perje, uljane boje, pastele, vodene boje, 
toon oblačići i strelice, teguće je stvoriti i potpuno 
novi kist kombiniranjem ponuđenih mnogobrojih 
postavki. Sjenčnje, osvjetljenje, sjene, sjaj, cijevi 
(tubes), razmaci i atributi za animaciju. Sve su to 
stvari koje je teguće kontrolirati. Osim Attribute 
editora, u tu svrhu teže poslužiti i Brush Preset 
izbornik. [1,3]
Tvorac Paint Effects alata je Duncan Brinsmead, 
glazbenik i softverski programer iz Toronta. Osim 
Paint Effectsa, stvorio je sustave Maya Hair i 
Maya Toon. 2008. primio je akademsku nagradu 
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za doprinos u razvoju Maya Fluids-a. Noviji 
radovi uključuju razvoj Maya nCloth sustava, i 
novi „Nucleus Dynamics solver framework“. [8]

2. Prije korištenja Paint efekata

2. Before using Paint Effects

Prije korištenja, dobro je osigurati da Paint 
Effects bude loadan: Window > Settings/
Preferences > Preferences > Tedules > Uključiti 
Paint Effects > Save > Restar Maya. Također 
bi bilo dobro, ako nije po zadanome, dodati 
Paint Effects meni u Rendering tedu kao i Paint 
Effects Panel u Panel meniju i Paint Effects 
policu: Window > Generl Editors > Script 
Editos > upisati sljedeće: loadNewShelf: “shelf_
PaintEffects.mel”; 
saveAllShelves $gShelfTopLevel; a zatim 
odabrati Command > Execute [1]

2.1	 Spremanje predefiniranih kistova na 
policu

2.1	 Saving Preset Brushes on the Shelf

1.	 Otvoriti Visor (Window > General Editor > 
Visor)

2.	 Kliknuti na Paint Effects tab i proširiti mapu sa 
kistovima, ako već nije.

3.	 Kliknuti na mapu koja sadrži preset brusheve 
koje želite na polici.

4.	 (Opcionalno) Stvoriti novu policu sa željenim 
preset brushevima.

5.	 Za spremanje nekog kista na policu, potrebno 
je srednjim klikom kliknuti na ikonu i odvući 
je u željenu policu koju ste stvorili, a za 
spremanje svih kistova u datoteci, odvući kist 
iz datoteke s kistovima na policu.

6.	 Za spremanje odabrati Windows > Settings 
and Preferences > Shelf Editor > Save All 
Shelves. [1]

2.2	 Bitne kratice

2.2	 Important Hotkeys

Otvranje Paint Effects Panela 8
Otvaranje Template Brush 
Editora

Ctrl + B

Skaliranje kista Crtl + Drag&Drop u 
lijevo ili desno i odpustiti

Promjena širine B + Drag&Drop na 
lijevo ili desno i odpustiti

Promjena Paint Effects Surfce 
Offseta

M + Drag&Drop u lijevo 
ili desno i odpustiti

2.3	 Dobro je znati

2.3	 It is good to know

Paint Effects alat radi kao paintbrush (kist 
za slikanje). Kad se povlači s Paint Effects 
alatom, stvara se potez kojji je skup krivulja 
s informacijama i atributima koje definirju 
kako je efekt primjenjen na putanju linije. 
Dakle, teže se crtati na 2D platnu i stvarati 2D 
teksture ili slike ili u 3D prostoru.
Paint Efekti ne tegu se renderirati poteću 
Mental Ray sustava za renderiranje, već sate 
koristeći Maya Software. Ako želite renderirati 
scenu u Mental Rayu, koja sadrži Paint 
Effects entitete, potrebno je prvo paint efekte 
pretvoriti u poligone, NURBS objekte, ili neke 
druge renderabilne objekte. Za konverziju 
potrebno je odabrati Tedify > Convert > Paint 
Effects to Polygons.
Također je od velike važnosti optimizirati 
mrežu Paint Efekata, jer će ona ponekad 
postati toliko komplicirana i gusta da će se pre 
dugo renderirati, ili se neće uopće renderiraiti 
– Paint Effects > Mesh Quality Attributes.
Opaska: promjena segmenata ko što su Leaf 
Segments, Sub Segments, Split Max Depth 
ili Petal Segments teže promjeniti konačan 
izgled cijevi (tubes). No ipak, poželjno 
ih je držati na nižim vrijednostima, dok 
atribut Flatness tera biti točno na 1, jer teže 
dramatično reducirati broj trokuta u mreži, 
osobito ako je Tube Section postavljena na 
višu vrijednost.[1, 2, 6]

3. Osnovni pojtevi

3. Basic concepts

Osnovni pojtevi za Paint Effects su Potezi 
(Strokes), Kistovi (Brushes) i Krivulje (Curves). 
Slijedi kratak pregled kako funkcioniraju.
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3.1.1	 Potezi

3.1.1	 Strokes

Kada se crta na 2D platnu, Paint Effects 
primjenjuje izgled prema postavkama uzorka kista 
(Template brusha), a zatim „odbacuje“ geometriju 
poteza. Zato što nema geometrije na 2D platnu, 
neteguće je tedificirti potez ili primjeniti kist 
nakon što je naslikan na 2D platno. Kada se 
povlaći potez u 3D sceni, Paint Effects sprema 
potez zajedno sa scenom. Potezi u 3D sceni 
predstavljaju geometriju, pa prema tome imju i 
povijest konstrukcije i tegu se uređivati. Potez 
se teže prilagođavti na mnogo načina. Težete 
resetirati atribute kista primjenjenog na potez, 
a teguće je čak i primjeniti kist na postojeću 
NURBS krivulju. Iako po zadanome svaki potez 
ima jedinstven kist primjenjen na njega, teguće 
je jedan kist primjeniti na više poteza, pa onda 
svaka promjena na tom jednom kistu utječe na sve 
poteze na koje je taj kist primjenjen. [1]

3.1.2	 Tipovi poteza

3.1.2	 Types of Strokes

Postoje dva osnovna tipa poteza: jednostavan 
potez i potez koji simulira rast.

a.	 Jednostavan potez
Kod jednostavnog poteza, izgled, tj. kist je 
primjenjen direktno na putnju linije.

b.	 Potez koji simulira rast
Potez sa cijevima (tubes) simulira prirodan 
rast. Kako se potez povlači, cijevi izlaze iz 
njega, ko što biljke rastu iz poredanih sjemenki. 
Cijevi rastu, dijele se, i produžuju u odvojenim 
koracima preko putanje, rastući segment više na 
svakom koraku. Dakle, kako se potez crta, Paint 

Effects uzorci „smještaju se“ na putanju krivulje 
bazirajući se na ulaz koji dolazi iz miša ili stylusa. 
Kada je potez brzo povućen, uzorak iscrtavanja 
je udaljeniji, a ako je povućen sporije, točke 
uzorka (na primjer drva) gušće su, tj međusobno 
bliže. Kada generira točke uzorkovanja, Paint 
Effects smješta nove cijevi uzduž putanje između 
trenutne i zadnje generirane točke i stvara cijevi. 
Kada se završi sa crtanjem, cijevi će ili nastaviti 
rasti do kad ne dosegnu kraj svog životnog vijeka 
(definiranog brojem segmenata cijevi), ili će pak 
prestati rasti, tako da cijevi blizu kraja linije budu 
manje nego li one s početka. Cijevi tegu rasti u 
gotovo beskrajnoj raznovrsnosti oblika i formi 
(na primjer, biljke, kosa, vatra, voda) ovisno o 
atributima koji su postavljeni za taj potez. Na 
2D platnu, potezi sa cijevima tegu brzo stvarati 
kompleksne slike .U 3D sceni, cijevi tegu rasti u 
3D prostoru. [1, 2]

3.2	 Kistovi

3.2		  Brushes

Sve postavke atributa koje definiraju izgled i 
ponašanje linija zajednički se zovu Kist (Brush). 
Kada se crta, uzorak kista zajedno sa njegovim 
postavkama sprema se u novi kist, koji se zatim 
primjenjuje na potez, dajući mu jedinstveno ime. 
Uzorak kista ili Template Brush jednostavno 
je kolecija atributa i postavki koji definiraju 
kist koji će biti primjenjen na liniju. On je kao 
paleta - mjesto na kojem se boje miješaju prije 
nego se primjenjuju. Sve promjene koje se stvore 
na paleti utječu na to kako će potez koji ste 
povukli izgledati, ali ne utječu na linije koje su 
prethodno napravljene. Teguće je spremiti kistove 
i specifične kombinacije postavki. Spremljeni 

Slika 1		 Jednostavan potez na 2D platnu i u 3D sceni [1]

Figure 1	 Simple stroke on 2D Canvas and 3D Scene

Slika 2		 Potez sa cijevima koji simulira rast [1]

Figure 2	 Stroke with tubes that simulates growth
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kistovi zovu se Preset Brushes (predefinirani 
kistovi). Kada se odabere Preset Brush, njegove 
postavke kopiraju se u Template Brush, gdje ga se 
teže dodatno podešavati prije nego što se primjeni 
na liniju. Svaka napravljena promjena na preset 
brushu se ne sprema, osim ako korisnik to ne 
napravi. Teguće je stvoriti vlastiti Preset Brush ili 
koristiti već gotove preset brusheve koje dolaze s 
Paint Effects alatom. [1, 3]

Slika 3		 Scena načinjena poteću različitih kistova [3]

Figure 3	 Scene made by various brushes

3.2.1	Kako je izgled (kist) primjenjen na 
potez

3.2.1	How the appearance (brush) is applied 
to stroke

Izgled je primjenjen na potez u obliku 
preklapajućih uzoraka u trenutku kada je potez 
prikazan. Ako je vrsta poteza jednostavna (nema 
cijevi), uzorak će biti primjenjen uzduž cijele putanje.

Slika 4		 Veza između pečata i primjene istog na 
jednostavan potez na 2D platnu [1]

Figure 4	 The relationship between the single stamp and 
its application on a simple stroke in 2D canvas

Ako putanja simulira rast, ima cijevi, uzorci nisu 
primjenjeni sate uzduž cijele putanje linije, već i 
uzduž putanja cijevi koje nastaju prilikom crtanja.

Slika 5		 Primjena izgleda na potez sa cijevima [1]

Figure 5	 Application of brush on stroke with tubes

Ukoliko se radi na 2D platnu, teguće je istog 
trenutka vidjeti izgled primjenjen na potez. 
Međutim, prilikom rada u 3D prostoru, potezi 
su prikazani kao Wireframeovi (način prikaza 
sa 3 dimenzije). Kako wireframe prikaz 
poteza otegućuje brz, neposredan feedback 
bez dimenzionalnih performansi, s vremenom 
bi svatko poželio vidjeti kako potez zaista 
izgleda bez da tera renderirati 2D sliku kako bi 
to vidio. To se teže učiniti koisteći interaktivni 
način renderiranja poteza u Paint Effects 
panelu koji se zove Scene Painting View. To je 
snimak pogleda na scenu gdje se potezi tegu 
vidjeti u wireframe načinu, ili pak primjeniti 
izgled na poteze prilikom crtanja u efektima, 
renderirati poteze interaktivno. [2]

3.3 Krivulje

3.3 Curves

Paint Effects vrlo je dobro integriran s 
ostatkom Maye zbog oslanjanja na krivulje 
(Curves). Tako da bilo što povezano s 
krivuljom teže na sebe imati priključen Paint 
Efekt. Dakle, Paint Effect potez je krivulja 
priključena na skrivenu, ishodišnu NURB 
krivulju (ili sate liniju). Ishodišna NURB 
krivulja definira oblik putanje linije. Krivulja 
koja je načinjena zajedno s potezom po 
zadanim je postavkama skrivena. Pritiskom 
na Ctrl+H(Show Hidden), a zatim na 4 
(Wireframe Tede) težete vidjeti krivulju. 
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Krivulja koja se pojavi prilično je gusta te je 
napravljena od individualnih CV-eva. Njihovu 
gustoću uzorkovanja teguće je mijenjati poteću 
opcije Sample Density. Dobra metoda za 
manipulaciju gusto uzorkovane krivulje je Soft 
Select metoda označavanja.
Kist, odnosno neki izgled (Template Brush) 
teguće je primjeniti na bilo koji objekt koji je 
asocira s krivuljama, na primjer, ako stvorite 
Surfaces kuglu (NURBS Sphere), u Isospam 
načinu (desni klik + vučenje miša > Isospam) 
svaka je komponenta zapravo krivulja. I tako 
na svaku tu krivulju lagano težete primjeniti 
kist poteću naredbe Paint Effects > Curve 

Utilities > Attach Brush to Curve.
Slika 6		 Zadani kist pridružen na CV krivulju u Isospam 

načinu

Figure 6	 Default brush attached on CV curve in Isospam 
Tede

Raspon CV krivulja uvijek će biti manji ako 
potez povućete brže, no sve se naknodno 
teže promijeniti u Attribute editoru pod 
Sample Density. Ali težete otići i u Surfaces 
> Edit Curve > Rebuild Curve. U izborniku 
postoji opcija Number of Spans. U našem 
slučaju imao je brojku 114. Ako je promjenite 
u 15, vidite da na krivulji imate 15 vertexa 
za kontrolu. Time ste dobili tegćnost lakšeg 
rukovanja ali i opzimiziraniju krivulju. [5,7]

Osim promjene optimiziranja krivulje, u 
Attribute editoru za krivulju postoje i mnogi 
drugi parametri. Na primjer, End Bounds 
postaje bitan kada želite animirati krivulju, a 
tu je i Pressure Scale pod Pressure Mapping 
koji definira kako će pritisak biti primjenjen 
na potez. To radite poteću funkcije koju 
kontrolirate na globalnoj razini (Global Scale) 
ili posebno na bilo kojem djelu krivulje. Pa 
tako i bez stylusa težete krivulju na početku 
učiniti vrlo uskom a na kraju debelom. Svi 
ti atributi kontroliraju ponašanje i izgled 
Paint Effects čvorova kistova (Brush Nodes). 
Tegućnosti su beskonačne. [1, 4]

Slika 7		 Ukoliko je krivulja gusto uzorkovana, najbolja 
metoda označavanja je Soft Select Vertex

Figure 7	 If the curve has big sample density, the best 
selecting method is Soft Select Vertex

Slika 8		 Rebuild Curve Option prozor - primjer 
smanjenja raspona CV-eva i optimiziranja 
krivulje

Figure 8	 Rebuild Curve Option window – example of 
reducing spans of CVs and optimizating curve
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Slika 9		 Kategorizacija atributa kista u Attribude Editoru

Figure 9	 Categorization of brush attributes in Attribute 
Editor.

4. 2D slikanje

4. 2D painting

4.1	 2D – 2.5D 

4.1	 2D - 2.5D 

Za bolje razumijevanje 2D platna i kistova, 
te u konačnici sateg Paint Effects sustava, treba 
imati na umu da je 2D platno ustvari 2.5D platno. 
Neki kistovi, kao što je primjerice Hair kist ili 
Ivy kist, imaju otegućenu dubinu (Depth). Ako 
pogledate u Template Brush Tab > Channels 
težete vidjeti da je kanal „Depth“ označen. 
U primjeru gore najprije je povućen potez Ivy 
kistom, nakon čega je preko njega povućen 
potez Gold kistom. Vidljivo je da je Gold potez 
smješten djelomično ispod prvog poteza. [4,7]

4.2	 Slikanje na platnu

4.2	 Painting on Canvas

Kako bi se slikalo na platnu, potrebno je učiniti 
sljedeće: 

1.	 Postavite platno, ako je potrebno. 
2.	 Učinite jedno od sljedećeg:

Ako koristite olovku i tablet, izmjenjujete pritisak 
preslikavanja po želji (Paint Effects > Paint Effects 
Tool). Težete mapirati do tri atributa kista na pritisak 
olovke definirane minimalnom i maksmalnom 
razinom pritiska.

Slika 11	 Postavke poteza – osjetljivost na pritisak u 3 
mape

Figure 11	 Stroke settings – pressure sensitivity in 3 maps

Slika 10	 Detenstracija dubine na 2D platnu

Figure 10	 Detenstration of depth on 2D canvas 
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Ako želite ignorirati pritisak preslikavanja, 
jednostavno odznačite Brush > Use Stylus Pressure.

3.	 Za odabir kista označite Visor (Brush > Get 
Brush) ili na platformi odaberete kist kojim 
želite slikati. Postavke odabranog kista 
kopiraju se na uzorak kista.

4.	 U Visoru se nalaze sve teksture, slike, 
čvorovi sjenjčanja (shading nodes) u 
jednom projektnom prozoru.  
Savjet: Neki najčešći kistovi nalaze se i u 
Paint Effects polici ispod glavnog izbornika.

Slika 12	 Visor prozor

Figure 12	 Visor window

5.	 Ako je potrebno izmijenite postavke uzorka 
kista (Brush > Edit Template Brush).

6.	 Ako slikate besprijekornu teksturu koja se 
ponavlja, postavljate odgovarajuće Wrap and 
Roll opcije. 

7.	 Povučete preko platna.

4.3	 Tipovi kista – Bojenje, gumica 
premazivač, zamučivać

4.3	 Brush Types – Paint, Erase, Smear, 
Blur

Bilo koji kist odabran u Visoru ili proizvoljno 
uređen težete koristiti u sljedećim načinima: Pain 
(bojenje), Erase (gumica), Smear (premazivač), 
Blur (zamučivać). Dok Paint način dodaje piksele 
na čisto platno ili scenu, Erase način ih uklanja i 
na mjestima gdje je primjenjen otkriva osnovno 
platno. Težete obrisati boje s platna koristeći bilo 
koji kist postavljanjem opcije kista za brisanje. Pri 
tome je teguće zadržati oblik kista. Na primjer, 
ako kist ima lišće, boja je uklonjena gdje su listovi 
obojeni. Brisanje također uklanja alfu. [2]

Slika 13	 Brisanje poteću Grass kista(lijevo) i zadanog 
kista (desno)

Figure 13	 Erasing with Grass brush (left) and default 
brush (right)

4.4	 Čišćenje platna

4.4	 Clear canvas

Čišćenje platna zamjenjuje cijelo platno 
sa zadanom čistom bojom. Za čišćenje platna 
potrebno je:

1.	 Učiniti jedno od sljedećeg:
•	 Odaberete Canvas > Clear. Platno se čisti 

zadanom čistom bojom. 
•	 Kliknete na Clear Canvas ikonu  na alatnoj 

traci.
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Za postavljanje zadane čiste boje platna
1.	 Odaberete Canvas > Clear >  Otvara se 

prozor Clear Color. 
2.	 Kliknete na okvir boje kako bi otvorili Color 

Chooser.
3.	 Odaberete boju platna i kliknete Clear ili 

Apply. 
Zadana boja platna je bijela, no ako koristite 
blještave i sjajne kistove kao što su Glows, Fire, 
Galactic i slično vjerojatno će tamnija boja biti 
prikladnija, kao u primjeru ispod. [3,4]

Slika 14	 Galactic i Lightning kistovi na crnom platnu

Figure 14	 Galactic i Lightning brushes on black canvas

4.5	 Wrap i Roll platno

4.5	 Wrap and Roll Canvas

Tekstura koja se ponavlja je tekstura stvorena 
od pločica ili slika koje se ponavljaju u mreži. 
Bešavna tekstura koja se ponavlja je ona gdje se 
ne teže vidjeti granica svake pločice jer se slike 
slažu kontinuirano na rub svake pločice.
Težete stvoriti neprekidne teksture koje se 
ponavljaju u Paint Effectsu poteću Wrap 
opcije. Wrap opcija otegućuje da se boji preko 
ruba platna i da se taj potez nastavlja dalje na 

suprotnom rubu, kao da je platno uvijeno u 
cilindar i spojeno na rubovima. Težete uviti platno 
okomito, vodoravno, ili oboje.

Slika 15	 Ponavljajuća tekstura (lijevo) i ponavljajuća 
bešavna tekstura (desno) [2]

Figure 15	 Repeating texture (left) and seamless repeating 
texture (right)

4.5.1 Wrap platno

4.5.1 Wrap canvas

Kako bi se platno utetalo (Wrap) potrebno je: 
1.	 Postaviti platno po želji
2.	 U Paint Effects Globals prozoru označiti opcije 

Wrap H (horizontalno) i Wrap V (vertikalno).
3.	 Obojati platno preko rubova – kada kist dođe 

do desnog ruba, nastavlja se preko lijevog
4.	 Otvoriti teksturu datoteke u Attribute Editoru 

klikom na Place2Dtexture 
5.	 Uključiti Wrap U i Wrap V opcije. 
6.	 U Repeat UV području upišete broj kopija 

tekstura koje želite preslikati unutar područja 
prekrivanja u U ili V površinskih smjera ili 
oboje. [1,2]

4.5.2	Roll platno

4.5.2	Roll canvas

Ako previjete platno, težda biste željeli prikazati 
gdje se rubovi spajaju. To težete učiniti poteću 
roll tegućnosti. Roll opcija savija platno kao da je 
utetano u cilindar (korisno za cilindrične ili sferične 
teksture), tako da se slike kreću kontinuirano s 
lijeva na desno ili odozgo prema dolje.
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Slika 16	 Originalno platno (lijevo) i isto platno uvinuto 
horizontalno (desno) [2]

Figure 16	 Original canvas (left) and the same canvas 
rolled horizontally left to right (right)

5. 3D slikanje

5. 3D painting

Potezi napravljeni u 3D načinu su 
dimenzionalni i daju se uređivti. Svaki potez 
ujedno je i objekt u sceni. Tegu se crtati na mreži 
u perspective view-u ili direktno na neki drugi 
objekt, nakon čega se tegu transformirati te 
im se tegu promjeniti promijeniti oblik i ostali 
atributi. Na raspolaganju je čitav niz kistova, 
od tradicionalnih tehnika (uljane boje, markeri, 
airbrushevi, pastele...) koji u 3D sceni imaju 3 
dimenzije. No, slikanje s tradicionalnim kistovim 
sate dodiruje tegućnosti Paint Effectsa. Crtanje 
poteza sa cijevima (Tubes) otvara novi svijet 
tegućnosti. Cijevi spadaju u atribute kista, pa 
slijedi kratak pregled načina organizacije različitih 
sekcija unutar Attribute Editora. [3,1]

5.1 Atributi kista

5.1 Brush Attributes

Jednostavno rečeno, svaki Paint Effect potez 
unutar Maye dolazi s krivuljom, potezom i 
izgledom. Svaki potez rezultira pojavom dva taba 
u Attribute editoru. Pod StrokeShapeImeKista 
nalaze se atributi za manipuliranje potezom.  
U što spada Pressure Scale, End Bounds, Pressure 
Mapping, i ostali atributi poteza. Dok tab 
ImeKista sadrži atribute koji definiraju izgled i 
ponašanje kista primjenjenog na neki potez.

Slika 17	 Atributi kista u Attribute Editoru

Figure 17	 Brush Attributes in Attribute Editor

Svi atributi od Brush Type do Mesh su na neki 
način inicijalizacija sateg poteza – globalne 
kontrole nad njime. Atributi od Shading do 
Glow definiraju kako će potez izgledati prilikom 
renderiranja (Maya Render). Sekcije od Tubes 
do Flow Animation diktiraju način na koji potez 
izrasta iz krivulje i kako je animiran s obzirom na 
krivulju ili vrijeme. [1,4]

5.1.1	 Cijevi

5.1.1	 Tubes

Kada govorite o cijevima, govorite o bilo 
čemu što izrsta iz krivulja koje ste stvorili. 
Ako napravite običnu liniju sa zadanim kistom 
i u Attribute Editoru uključite opciju Tubes, 
težete vidjeti cijevi koje izlaze iz te krivulje. 
Rezultat je nešto puno drugačije od početne 
krivulje, nešto što bi potencijalno tegla biti 
trava ili štapići.
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Slika 18	 Primjena cijevi na običnom potezu sa zadanim 
kistom

Figure 18	 Applying tubes on plane stroke with default 
brush

Neki kistovi zadano dolaze sa cijevima (na 
primjer, drva i biljke).

Slika 19	 Neki potezi sa cijevima [1]

Figure 19	 Some of the brushes with tubes

Dok potez leži na ravnini ili površini, cijevi se tegu 
širiti u 3D prostor. Dakle, one nisu sate teksture, 
već su sagledive sa svih kuteva u prostoru. 
Ako reducirate segmente cijevi na sate jedan, 
od te cijevi težete pokušati napraviti neki oblik, 
podešavajući različite komponente širine, dužine 
i ostaloga. Što ćete više segmenata dodati, to 
ćete točnije teći kreirati oblik koji ste naumili. 
Na primjeru koji slijedi, u Width Scale funkciji 
dodano je nekoliko točaka na jedan Tube segment 
iz prethodnog primjera. [4,1]

Slika 20	  Promjena oblika cijevi poteću Width Scale 
funkcije

Figure 20	 Changing overall shape using Width Scale 
function

5.2	 Za korisnike Wacoma

5.2	 For Wacom users

Ako se umjesto miša koristi tablet, jači pritisak 
stylusa uzrokovat će širi kist, tj. izgled će biti 
primjenjen na krivulju „deblje“. Za stylus, teže 
se isplanirati osjetljivost na pritisak u 3 atributa. 
Na primjer, ako mapirate veličinu, gustoća i 
duljina cijevi biti će definirana jačinom pitiska, a 
pojačanje pritiska pojačat će i globalnu veličinu 
kista, ali i broj cijevi. Većina preset brusheva 
imaju te vrijednosti postavljene na zadano ali to 
se teže mijenjati. Ono što težete promijeniti su 
Pressure map, Pressure min i Pressure max, što 
otvara tegućnost izrade vlastitih predefiniranih 
kistova (Preset Brusheva). [6]

5.3	 Postavke za slikanje u 3D pogledu

5.3	 Options for painting in 3D view

Kada slikate u sceni, jednostavni potezi 
izgledaju kao krivulje, a oni sa cijevima u 
wireframe prikazu. Izgled nije primjenjen na 
potez tako dugo dok se ne napravi naknadno 
renderiranje, koje otegućuje trenutačnu 
povratnu informaciju i dovoljno detalja kako 
biste znali „što se događa“. Za brže crtanje, 
bilo bi dobro podesiti display kvalitetu poteza
Savjet: Preporučljivo je crtati u Perspective 
pogledu, a ne ostalim ortagonalnim pogledima 
jer težete dobiti neočekivane rezultate.
Kako bi se prikazao Painting view, na donjoj 
traci s izbornicima odabirete
1.) Panels > Panel > Paint Effects. 
2.) Paint > Paint Scene ili jednostvno 
pritisnete 8 na tipkovnici. Time dobivate 
prozor sa Paint Effects izbornicima: Paint, 
Canvas, Brush, Camera, Resolution, Object 
Shading, Display, Stroke Refresh, Panels, 
a dobivate ujedno i perspektivni pogled. Za 
povratak natrag odabirete Panel > View > 
Perspective
Opcija Stroke Refresh nudi sljedeće 
tegućnosti: 
Off - potez se prikazuje kao wirefrme u 
display kvaliteti 
Wireframe - potez se prikazuje kao wireframe 
u 100 postotnoj display kvaliteti kada se 
zumira i kreće kroz scenu.
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Rendered - Svakim zootem i promjenom kuta, 
pogled se renderira ispočetka
Selected only - Sate se selektirani potezi 
renderiraju prilikom zumiranja, dok se 
neselektirano prikazuje u Wireframe kvaliteti.
Ako se odlučite renderirati sve krivulje u 
sceni, kliknete Redraw gumbić  ili 
odaberete Stroke Refresh > Rendered.
Ako u sceni imate kompleksnu geometriju 
krivulja i potrebno je dugo vremena za 
Redraw proces, pritiskom n ECS, cijeli se 
proces zaustavlja. Kako bi cijelo vrijeme 
vidjeli renderirani izgled paint efekata, 
odabirete opciju Draw as Mesh u Attribute 
Editoru ili Chanel Boxu. Nije dobro ovu opciju 
stalno držati uključenom, jer će program sporo 
raditi. U izborniku Camera, težete promijeniti 
pogled (persp, front, side, top). Promjena 
kamere odmah aktivira i Redraw opciju, tako 
da će se sve renderirati. [1,2,6]
Za promjenu kamere odabirete koju kameru 
želite iz izbornika Panels > Orthographic 
submenija. 
Za promjenu rezolucije odabirete Resolution 
izbornik. Preporučljivo je raditi u manjoj 
rezoluciji jer će program brže raditi. Izgled 
će biti pikselast, ali će konačno renderiranje 
biti puno brže. Težete odabrati Full (prikazuje 
maksimlan broj piksela), 75%, 50%, 25%, 
15% (pokazuje pogled prema odabranom 
postotku pune rezolucije, zauzima prostor i 
povećava zoom nivo), Actual Size (ekvivalent 
gumbiću 1:1 na traci s izbornicima, a pogled 
se prikazuje u pravoj veličini, bez zooma).
U izborniku Object Shading, težete promjeniti 
načine sjenčanja objekata u sceni: 
Wireframe – Prikazuje rubove poligonalnih 
mreža i parmetarnih krivulja na površinama. 
Ta kvliteta prikaza dolazi po zadanim 
postavkama.
Shaded – renderira sve površine, mreže i 
čestice (particles) u glatko zasjenčane objekte.
Use default Lighting – površine se pojavljuju 
kao potpuno osvjetljene po Paint Effects 
zadanom svijetlu. 
Use All Lights – Površine se pojavljuju uz sva 
svijetla u sceni. 
Disply fog – U pravom svijetu, attesfera 
sadrži sitne čestice (magla, dim, prašina). 

Takvi efekti čestica utječu na izgled attesfere 
i izgled objekata u attesferi. Ova opcija dakle 
otegućuje da simulirate efekt, attesferskih 
čestica koristeći maglu okoliša. Ako koristite 
Physicl Fog u sceni, težete vidjeti kako Paint 
efekti izgledaju u renderirnom načinu uz 
maglu. [1,6]

Slika 21	 Scene sa i bez fizičke magle [2]

Figure 21	 Scene with and without Phisycal Fog

5.4	 Slikanje po objektu

5.4	 Painting on object

Za slikanje na NURBS objekte ili poligone, 
prvo treba objekt učiniti da bude „obojiv“ 
(paintable). Tako Paint Effects stvara krivulju na 
površini objekta i pričvršćuje nastalu liniju na 
objekt. Kada transformirte takav objekt, linija se 
transformira zajedno s njime. 
Kako crtate, krivulja ne „napušta“ objekt, osim 
ako mišem (stylusom) ne dođete do sljedećeg 
objekta koji je zadan na „paintable“, pa se krivulja 
nastavlja na sljedećem objektu.
Za slikanje po objektu potrebno je:

1.	 Označiti NURBS ili poligon objekt
2.	 Označiti Pint Effects > Make Paintable.
3.	 (Make Paintble primjenjuje se sate trenutno 	
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označeni objekt. Svaki objekt na koji je opcija 
prethodno primjenjena, više to neće biti).

4.	 Označite Paint Effects > Paint on Paintable 
Object

5.	 U Visoru (Paint Effects > Get Brush), ili 
sa police, odaberete brush preset koji želite, 
tedificirate potez i izgled kista po želji.

6.	Paint Effects animacija

6. Paint Effects Animation

Kada se govori o animaciji i Paint efektima, 
najčešće se misli na simulacije prirodnih sila. U 
sekciji Tubes u Attribute Editoru, u podmeniju 
Behavior postoji nekoliko parametara koji se tegu 
mijenjati i animirati poteću Keyframeova i petlji. 
To su Diplacement, Forces, Turbulance, Spiral i 
Bend. Ispod se nalazi sekcija Flow Animation koja 
služi za simulaciju prirodnog toga ili rasta. [1,4]

6.1	 Premještanje

6.1	 Displacement

Displacement postavke koriste se kako bi se nešto 
izobličilo ili promijenilo. U tu svrhu služe parametri 
Noise, Wiggle i Curl. Svaki od tih parametara ima i 
pripadajuću frekvenciju. Na primjer, jačina uvinuća 
teže se definirati pod Curl opcijom rangom brojeva 
od 0 do 1, gdje 0 znači da uvinuća nema, a 1 znači 
da je uvinuće maksimalno. Curl Frequency definira 
količinu uvojaka. Ista pravila vrijede i za ostale 
Displacement parametre.

Slika 22	 Odnos parametara Curl i Curl Frequency na 
cijevi [1]

Figure 22	 Relation between Curl and Curl Frequency 
parameters on tube

6.2	 Sile

6.2	 Forces

Forces sekcija u Mayi služi za simulaciju 
prirodnih sila u koje spadaju Path Follow, Path 
Attach, Curve Follow, Curve Attach, Curve 
Max Dist, Surface Attach, Max Attach Distance, 

Random, Gravity, Surface Collide, Deflaction 
i mnoge druge. Ukratko, Path Follow definira 
magnitudu sile koja pokušava natjerati cijevi da rastu 
u istom smjeru kao i potez, također ima raspon od 0 
do 1. Ako je vrijednost 0, nema sile na cijevi, a kako 
vrijednost raste, cijevi pobliže prate smjer poteza.[1,2]

Slika 23	 Isključen Path Follow (lijevo) i postavljen na 
vrijednost 0.5 (desno) [1]

Figure 23	 Path Follow unabeled (left) and Path Follow set 
on 0.5 (right)

Slično funkcioniraju i ostale opcije. Random 
parametar definira jačinu slučajnosti (intenzitet i 
smijer cijevi) a Gravity jačinu sile teže.

Slika 24	 Primjeri djelovanja intenziteta slučajnosti 
na cijevi – isključen (lijevo), 0.5(sredina) i 1 
(desno) [1]

Figure 24	 Examples od Random parameter affecting on 
tubes – unabeled (left), 0.5(middle), 1(right)

Slika 25	 Primjeri djelovanja različitih intenziteta sile teže 
na cijevi, redom: 0, 1, 2, 3 [1]

Figure 25	 Examples of various gravity intensities affecting 
on tubes

6.3	 Turbulencija

6.3	 Turbulence

Turbulencija označava određenu silu 
uzburkanosti, odnosno, nepravilnog kretanja 
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uzrokovanog nekom vanjskom silom (npr. 
strujenjem zraka). Tipovi turbulencije u Mayi 
su:Off, Local Force, World Force, Local 
Displacement, World Displacement, Grass 
Wind, Tree Wind, Interpolation, Frequency, 
Turbulance Speed, Turbulance Offset. U 
praksi, ako postoji grupa poteza, na njih se 
najčešće primjenjuje World Force ili World 
Displacement, jer se lokalne sile oslanjaju sate na 
lokalne cijevi. Grass Wind simulira kretnje slične 
travi na koju djeluje vjetar, dok je Tree Wind jači 
i djeluje na djelove bliže korijenu. [1,2]

6.4	 Kako napraviti Flow animaciju

6.4	 How to make Flow animation

Za efekt izrastanja drva, trave, gljive, ili bilo 
koje druge biljke iz zemlje, najbolje je koristiti 
Flow Animation efekt. U nastavku slijede koraci 
kako napraviti jednostavnu Flow animaciju sa 
primjenjenom turbulencijom.
1.) U Visoru odaberete kist po želji. U ovom 
primjeru korišten je Ivy kist. 
2.) Označite Tree Wind u Turbulance sekciji te 
podesite brzinu, jačinu i frekvenciju djelovanja sile. 
3.) U Timelineu povećate trajanje animacije na 144 
frameova, tako da ukupno traje 6 sekundi. 
4.) Pritiskom na Playback vidi se da na biljku djeluje 
sila vjetra, no nakon 6 sekundi vrati se u početno 
stanje i animacija počinje ispočetka. Ako koristite 
turbulenciju na pozadinske biljke u sceni, efekt reza 
težete lako izbjeći a time i optimizirati kretnju. Dakle 
pokreti biljke teraju se staviti u petlju. To napravite 
tako da odaberete Paint Effects > Brush Animation 
> Loop Brush Animation > 
5.) Pod Cycle frames upisujete vrijeme trajanja 
petlje. Po želji težete promijeniti i brzinu turbulencije 
i rasta. Kliknete na Loop. [5]

6.) Pod Flow Animation >Flow Speed određuje 
se brzina rasta. Kako bi stvar funkcionirala treba 
otegućiti Stroke Time i Time Clip opcije. Start 
Time postavljen je na 0, a End Time na 96, tako da 
biljka raste prve 3 sekunde, a do 6 sekunde vijori na 
vjetru. [4]

7. Zaključak

7. Conclusion

U radu su navedene najbitnije značajke Paint 
Effects alata, koje početniku mogu poslužiti 
kao vodič za upoznavanje sučelja, izbornika i 
osnovnih alata u Paint Effects domeni Maye. 
Paint efekti se u računalnoj grafici često 
podcjenju jer koriste predefinirane opcije, pa 
na prvi pogled ne pružaju mnogo mogućnosti 
prilikom kreativnog procesa stvaranja 3D 
modela ili animacije. Ovaj rad prikazuje 
osnovna svojstva, no baš kao i u svakom 
drugom području, za bolje razumijevanje uvijek 
je najbolje isprobati kako što radi i na posljetku 
eksperimentirati.

Slika 26	 Faze kretanja Ivy biljke u 6 sekundi

Figure 26	 Tetion stages of Ivy plant in 6 seconds

8. Reference

8. References

[1]	 Autodesk Maya User Guide, dostupno:
	 http://download.autodesk.com/global/docs/

maya2014/en_us/index.html?url=files/
Paint_Effects_and_3D_Paint_Tool_over-
view.htm,topicNumber=d30e370034/, 
2014.

[2]	 Autodesk Maya Support, dostupno:
	 http://knowledge.autodesk.com/support,  

2015.
[3] 	 E-knjiga:  

Dariush Derakhshani: Introducing Au-
todesk Maya 2015, Sybex; 1 edition, 



144

POLYTECHNIC  &  DESIGN			        					                      Vol. 4, No. 2, 2016.

2014. Dostupno: http://ebook-dl.com/item/
introducing-autodesk-maya-2015-dariush-
derakhshani/

[4]	 Video tutorial: 
Lee Fraser, Autodesk sr. technical special-
ist: Discover Paint Effects in Maya 2013, 
dostupno: 
https://www.youtube.com/results?search_
query=maya+paint+effects/

[5]	 Video tutorial: 
Mathew Guild: Looping Paint Effects 
Brush Animation Easily in Maya Using 
Loop Brush, 

[6]	 E-knjiga: Todd Palmer: Mastering Au-
todesk Maya; Sybex, 2015., dostupno: 

	 https://books.google.hr/books?id=A5YvCg
AAQBAJ&lpg=PA419&dq=autodesk%20
maya%20paint%20effects&pg=PA421#
v=onepage&q=autodesk%20maya%20
paint%20effects&f=false/

[7]	 Stručni članak:Vusić, Bernik, Rohtek: 
Maya Paint Effects, 2014., dostupno:

	 http://hrcak.srce.hr/index.
php?show=clanak&id_clanak_
jezik=194398&lang=en

[8]	 Duncan Brinsmead, Xmedia Mentor, 
dostupno: http://www.xmedialab.com/men-
tor/duncan-brinsmea

AUTOR · AUTHOR

Andrija Bernik – nepromjenjena biografija 
nalazi se u časopisu Polytechnic & Design  
Vol. 2, No. 2, 2014.


